在windows环境下用Sourcery CodeBench编译基于

am3359的u-boot

自从使用am3359以来，总觉得在linux下烧写flash是件麻烦事，而用虚拟机的话又不好Debug。于是笔者就在想能不能在windows下构建一个环境可以编译基于am3359的u-boot？这样烧写flash，Debug u-boot将会方便很多。

经过笔者几番尝试，终于找到适用的方法，思路如下：首先，我们需要模拟linux的操作环境；其次，我们需要交叉编译器来编译可以在ARM上运行的代码；最后，我们需要一个IDE作为框架环境，与模拟linux的操作环境和交叉编译器结合来共同完成编译u-boot。

这里，我们选用MinGW来模拟linux的操作环境，选择Sourcery CodeBench作为交叉编译器，使用ccsv5（基于Eclipse框架）作为IDE。

1.安装MinGW/MSYS
我们知道在linux下编译通过的c代码，如果它使用了自己的API，那么在windows下编译是不能通过的。但是linux的API的功能在windows下是能实现的。这里我们需要一款软件MinGW/MSYS。MinGW，即 Minimalist GNU For Windows，它是一个Windows特定头文件和使用GNU工具集导入库的集合，能够生成本地的Windows程序而不需要第三方动态链接库。MSYS，即Minimal GNU（POSIX）system on Windows，是一个小型的GNU环境，包括基本的bash，make命令等等。在编译u-boot时，我们需要从MinGW/MSYS中调用一些linux命令。还有，MinGW/MSYS是完全免费的。

下载MinGW：http://sourceforge.net/projects/mingw/files/
[image: image1.png]MinGW - Minimalist GNU for Windows .. cstrauss, cwilso11, eamie, keithmarshall
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运行mingw-get-inst-20120426，Next->Next->
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开始安装。

2. 安装Sourcery CodeBench Lite Edition for ARM EABI
Sourcery CodeBench是一款能够在ARM, Coldfire, MIPS, Power, X86, 等平台上作嵌              入式C/C++开发的完整的开发环境。而其中的Sourcery CodeBench Lite 为你提供免费的，基于命令行接口的交叉编译器。ccsv5自带有CGT编译器，而我们最终是要能够编译生成在am3359上裸跑的代码，所以我们需要ccsv5调用  Sourcery CodeBench Lite  的交叉工具链替代掉原来的CGT编译器来编译u-boot。                       
下载Sourcery CodeBench Lite Edition for ARM EABI:

 https://sourcery.mentor.com/sgpp/lite/arm/portal/subscription?@template=lite  [image: image5.png]Download Sourcery CodeBench Lite Edition for ARM

Sourcery CodeBench Lite 2012.03-56
EABI

Allversions...

Sourcery G++ Lite 2011.03.46
uClinux

Allversions...

Sourcery CodeBench Lite 2012.03.57
GNU/Linux

Allversions...

Sourcery CodeBench Lite 2012.03.42
Symbian0S

Allversions...




EABI: 用于RTOS或者没有os的硬件设备。这个配置不能用于构建内核或者应用程序。

uClinux：用于运行不带MMU的CPU上的linux系统。可以构建uClinux内核和应用程序。

GNU/Linux：这个用于运行带有MMU的CPU上的linux系统。可以构建linux内核和应用程序。
SymbianOS：用于编译Symbian应用程序。

[image: image6.png]Sourcery CodeBench Lite 2012.03-56 for ARM EABI
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运行 arm-2012.03-56-arm-none-eabi
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然后Next->Install。

3.构建u-boot工程并编译

为了移植u-boot我们需要做一些编辑工作，这时我们需要一个IDE。由于我们只需要一个框架平台，用它调用Sourcery CodeBench这样的交叉工具链和MinGW/MSYS下的一些linux命令来完成编译，这样Eclipse无疑是适合的选择。Eclipse，一个跨平台的集成开发环境，它本身只是一个框架平台，但是众多插件的支持，使得人们能够以Eclipse为框架开发自己的IDE。而ccsv5是基于Eclipse框架的，并且使用ccsv5还可以方便烧写flash和Debug，因此我们选择ccsv5。关于ccsv5的下载与安装，受篇幅所限，笔者不再详述，大家可以到ti官网上自行下载安装。

3.1安装嵌入式调试插件ZylinCDT
 ZylinCDT是一个免费的Eclipse的交叉调试插件，并且能够自动生成makefile。

 下载ZylinCDT：http://repo.or.cz/w/zylincdt.git
 选择zylincdt：4.16，点击zip下载。
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解压Zylincdt:
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打开CCSV5，Help->Install New Software...
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Add->Archive->Zylincdt\com.zylin.cdt.updatesite\content.jar

Name: zylincdt
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在Zylincdt Embedded CDT选项上打钩，Next>Next>

->I accept the terms of the license agreement

->Finish

[image: image18.png]Available Software
Check the items that you wish to install.

Work with: ~zylincdt - jar:fil:/G:/download/zylincdt/com zylin.cdtupdatesite/contentjarl/

Find more software by working with the *Available Software

[iype fier text ]

Version

100 Zylin Embedded COT

—
Details

‘Show only the latest versions of available software

Hide items that are already installed
Group items by category What i already installed?
Show only software applicable to target environment

Contact all update sites during install to find required software

@ <Back [ Net> ][ Fnsh | [ cancel





[image: image19.png]% Install

Review Licenses
Licenses must be reviewed and accepted before the software can be installed.

License text (for Zylin Embedded CDT 4.16.1):

ECLIPSE FOUNDATION SOFTWARE USER AGREEMENT
March 17, 2005

Usage OF Content

‘THE ECLIPSE FOUNDATION MAKES AVAILABLE SOFTWARE, DOCUMENTATION, INFORMATION AND/OR
OTHER MATERIALS FOR OPEN SOURCE PROJECTS (COLLECTIVELY "CONTENT'
USE OF THE CONTENT IS GOVERNED BY THE TERMS AND CONDITIONS OF THIS.
AGREEMENT AND/OR THE TERMS AND CONDITIONS OF LICENSE AGREEMENTS OR
NOTICES INDICATED OR REFERENCED BELOW. BY USING THE CONTENT, YOU

AGREE THAT YOUR USE OF THE CONTENT IS GOVERNED BY THIS AGREEMENT
AND/OR THE TERMS AND CONDITIONS OF ANY APPLICABLE LICENSE AGREEMENTS
OR NOTICES INDICATED OR REFERENCED BELOW. IF YOU DO NOT AGREE TO THE
TERMS AND CONDITIONS OF THIS AGREEMENT AND THE TERMS AND CONDITIONS
‘OF ANY APPLICABLE LICENSE AGREEMENTS OR NOTICES INDICATED OR REFERENCED
BELOW, THEN YOU MAY NOT USE THE CONTENT.

Applicable Licenses

Unless otherwise indicated, all Content made available by the Eclipse Foundation
s provided to you under the terms and conditions of the Eclipse Public

Taccept the terms of the license agreement

©1do not accept the terms of the license agreement

@ Back ] Nex-

Finish





3.2导入u-boot工程

由于只是测试所用，笔者下载的是征对beaglebone这块板子配置好的u-boot源码。 

File->New->Project
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将路径指向到已存在的u-boot中：
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3.3为u-boot工程设置一些选项

我们要设置好使用何种交叉工具链，指定好交叉工具链的路径，指定好要使用的MinGW/MSYS中linux命令的路径，然后做好编译u-boot时需要的编译选项。 

在工程u-boot处右击，选择Properties：
C/C++ Bulid ->Environment->Add

Name: CROSS_COMPILE

Value: arm-none-linux-gnueabi-
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Name: PATH

Value:

   D:\MinGW\bin;D:\MinGW\msys\1.0\bin;D:\Sourcery_CodeBench_Lite_for_ARM_EABI\bin
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在C/C++ Build下，选择Builder Settings，将Use default build command前面的钩取消，在下面Build command中添加： make  CROSS_COMPILE=$(CROSS_COMPILE)，选择Behavior，在Build(Incremental build)和clean 前打钩，将Build(Incremental build)后的all去掉：
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在C/C++ Build->Settings 中钩上GNU Elf Parser，然后在弹出的addr2line command和c++filt command中指明路径：

D:\Sourcery_CodeBench_Lite_for_ARM_EABI\bin\arm-none-linux-gnueabi-addr2line.exe

D:\Sourcery_CodeBench_Lite_for_ARM_EABI\bin\arm-none-linux-gnueabi-c++filt.exe
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在Project下选择Make Target->Creat:
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在Target name 中添加 distclean 点击OK，再用同样的办法添加am335x_evm_config。
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制作这两个选项是为make distclean 和make am335x_evm_config做准备的。由于做移植工作需要反复编译u-boot，在编译u-boot的过程中会产生一些中间文件和链接文件，当修改完u-boot再次编译时，它可能会调用原来的中间文件和链接文件，这样编译就会出错，这时就需要用到make distclean。make distclean是用来清除之前编译u-boot产生的多余的中间文件和链接文件，能保证再次编译不受上一次干扰。make am335x_evm_config则是用来配置板子的相应信息。 
3.4修改Makefile和mkconfig

由于Makefile和mkcong中有些命令在现有的环境中还无法使用，比如ln -s链接命令。Windows下的快捷方式虽然与linux下的链接文件比较相似，但实现机制并不相同，如果通过修改makefile来取代链接文件直接指向原文件的位置，那工作量可想而知。此时，我们需要一个工具junction。junction是 由Sysinternals 出品的一个免费的命令行工具，它可以创建和删除符号链接。这样我们修改makefile的工作量将大大减少。

下载Junction：http://technet.microsoft.com/en-us/sysinternals/bb896768
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将junction.exe拷贝到D:\MinGW\msys\1.0\bin下，然后双击它。

打开u-boot根目录下的Makefile，在文件末尾找到clobber clean 处，修改如下：

注：红色字体为要添加的部分。
打开u-boot根目录下的mkconfig，找到注释# Create link to architecture specific headers处，修改如下（左边为修改前，右边为修改后）：

注：红色字体为要添加的部分。

3.5编译u-boot
因为编译u-boot时会默认调用D:\MinGW\bin中的strip.exe，而我们需要调用的是Sourcery CodeBench中的arm-none-linux-gnueabi-strip.exe。那么我们只需要做简单地替换就行了，做法：将D:\Sourcery_CodeBench_Lite_for_ARM_EABI\bin中的arm-none-linux-gnueabi-strip.exe拷贝到D:\MinGW\bin中改名为strip.exe替换掉原来D:\MinGW\bin下的strip.exe。

在Project下的Make Target->Build中，选择distclean，点击build：
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如果编译提示没有/tmp目录，那么可以用D:\MinGW\msys\1.0下的msys.bat新建一个：

双击msys.bat，键入：

Mkdir  /tmp

Chmod  a+rwx  /tmp
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=== Build of configuration Default for project u-boot **=*

make CROSS_COMPILE=arm-none-Linux-gnueabi- distclean

awk (NF &R $1 I~ /*#/) { print $1 ": " §1 "_config; $(MAKE)" }' boards.cfg > .boards.depend
echo "add delete junction to this place”

add delete junction to this place

=== Build Finished ****




在Project下的Make Target->Build中选择am335x_evm_config，点击build：
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make CROSS_COMPILE=arm-none-Linux-gnueabi- am335x_evm_config
Generating include/autoconf.mk

Generating include/autocon .mk.dep

Configuring for am335x_evm board. ..

delete junction include/asm

Junction V1.6 - Windows junction creator and reparse point viewer
Copyright (C) 2002010 Mark Russinovich
Sysinternals - w.sysinternals. com

Deleted asm.
create junction include/asm

Junction V1.6 - Windows junction creator and reparse point viewer
Copyright (C) 2002010 Mark Russinovich
Sysinternals - w.sysinternals. com

Created: g:\My_Program\workspace\u-boot\include\asm
Targetted at: g:\My_Program\workspace\u-boot\arch\arm\include\asn

e+ Build Finished ****




在Project下点击Build Project，开始编译u-boot：
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arch/arm/ cpu/armv7 /start.o ~-start-group api/Libspi.o arch/arn/cpu/armi7/Libarm7.o
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drivers/usb/muzb/Libusb_musb.o drivers/usb/phy/1Tousb_phy.o drivers/video/1ibvidzo.o drivers/uatchdog/libwstchdog.o
Fa/crants/libcrants.o 2/exta/Libextats.o f2/fat/1ibfat.0 fs/fdos/ibdos.o fs/37Fs2/1ib3fFe2.0 F/reiserts/libreiserts.o
F2/ubifs/ Libubifs.o s/yarfsz/libystfsa.o 1ib/1ibfdt/1ibdt.o 1ib/libgeneric.o 1ib/1zna/Liblzna.o 1ib/1z0/1ib1z0.0
1ib/211b/1ibz.0 net/Libnet.o post/libpost.o bosrd/ti/an3asx/ Liban3asx.o —end-group
/5/My_Progran)workspace/ u-boot /arch/arm/ 1ib/eabi_conpat.o -t

G mingu/msy=/1.0/ e/ arn-2012.03/bin . ./ 1ib/ gec arm-none-Linux-gnueabi/4.5.3/armiat -Lgcc -Hap u-boot.msp -0 u-boot
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至此u-boot就编译好了。

由于笔者手上的板子没有NAND flash，它是从SD卡启动的，所以要用一个工具把u-boot.bin做成u-boot.img文件。笔者从网上下载了适用于windows下的mkimage工具，然后把MLO和做好的u-boot.img拷入分好区的SD卡中，结果顺利运行。

笔者做这件事情，一是大家不需要装虚拟机或者linux的物理机，二是对习惯在windows环境下操作的朋友提供一种工作模式，二是为刚从windows转移到linux中工作的人提供方便。笔者是在windows 7 系统32位环境下编译的u-boot，编译一次大概30分钟。由于笔者才疏学浅，文中不足之处还请多多包涵。

clobber:	clean


	@find $(OBJTREE) -type f \( -name '*.depend' \


		-o -name '*.srec' -o -name '*.bin' -o -name u-boot.img \) \


		-print0 \


		| xargs -0 rm -f


	@rm -f $(OBJS) $(obj)*.bak $(obj)ctags $(obj)etags $(obj)TAGS \


		$(obj)cscope.* $(obj)*.*~


	@rm -f $(obj)u-boot $(obj)u-boot.map $(obj)u-boot.hex $(ALL-y)


	@rm -f $(obj)u-boot.kwb


	@rm -f $(obj)u-boot.imx


	@rm -f $(obj)u-boot.ubl


	@rm -f $(obj)arch/powerpc/cpu/mpc824x/bedbug_603e.c


#	@rm -fr $(obj)include/asm/proc $(obj)include/asm/arch $(obj)include/asm


	@rm -fr $(obj)include/generated


#new: add delete junction to this place


	echo "add delete junction to this place"


	@[ ! -d $(obj)include/asm ] || junction -d $(obj)include/asm


	@[ ! -d $(obj)nand_spl ] || find $(obj)nand_spl -name "*" -type l -print | xargs rm -f


	@[ ! -d $(obj)onenand_ipl ] || find $(obj)onenand_ipl -name "*" -type l -print | xargs rm -f


	@[ ! -d $(obj)mmc_spl ] || find $(obj)mmc_spl -name "*" -type l -print | xargs rm -f





# Create link to architecture specific headers


#


if [ "$SRCTREE" != "$OBJTREE" ] ; then


	mkdir -p ${OBJTREE}/include


	mkdir -p ${OBJTREE}/include2


	cd ${OBJTREE}/include2


	rm -f asm


	ln -s ${SRCTREE}/arch/${arch}/include/asm asm


	LNPREFIX=${SRCTREE}/arch/${arch}/include/asm/


	cd ../include


	mkdir -p asm


else


	cd ./include


	rm -f asm


	ln -s ../arch/${arch}/include/asm asm


fi





rm -f asm/arch





if [ -z "${soc}" ] ; then


	ln -s ${LNPREFIX}arch-${cpu} asm/arch


else


	ln -s ${LNPREFIX}arch-${soc} asm/arch


fi





if [ "${arch}" = "arm" ] ; then


	rm -f asm/proc


	ln -s ${LNPREFIX}proc-armv asm/proc


fi





# Create link to architecture specific headers


#


if [ "$SRCTREE" != "$OBJTREE" ] ; then


	mkdir -p ${OBJTREE}/include


	mkdir -p ${OBJTREE}/include2


	cd ${OBJTREE}/include2


	rm -f asm


	ln -s ${SRCTREE}/arch/${arch}/include/asm asm


	LNPREFIX=${SRCTREE}/arch/${arch}/include/asm/


	cd ../include


	mkdir -p asm


else


	cd ./include


#	rm -f asm


#	ln -s ../arch/${arch}/include/asm asm


	if [ -d asm ] ; then


	echo "delete junction include/asm"


		junction -d asm


	fi


    echo "create junction include/asm"


	junction asm ../arch/${arch}/include/asm





fi


#new:add rm -r to delete a directory


rm -fr asm/arch





if [ -z "${soc}" ] ; then


	ln -s ${LNPREFIX}arch-${cpu} asm/arch


else


	ln -s ${LNPREFIX}arch-${soc} asm/arch


fi





if [ "${arch}" = "arm" ] ; then


#new:add rm -r to delete a directory


	rm -fr asm/proc


	ln -s ${LNPREFIX}proc-armv asm/proc


fi








